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BEVEZETŐ  

A munkadarab-befogó készülékek között szép számmal fordulnak elő csuklós mechanizmusok [1]. Ezek 
többnyire egyedi tervezésű gyártóeszközök. Az egyedi tervezést nagymértékben segíti a hasonló feladatoknál 
alkalmazott megoldások ismerete. A hasonló megoldások ismerete ötleteket, koncepciókat adhatnak, amik 
elvezethetnek a helyes megoldáshoz. Az ötlettől a megvalósításig többnyire hosszú út vezet. Mindenekelőtt 
az ötleteket ki kell dolgozni, a tényleges megvalósíthatóságukat meg kell vizsgálni.  Az ötletek kidolgozásá-
nak első szakasza a koncepcionális tervezés [2]. A koncepcionális tervezés eredménye gyakran egy ajánlati 
terv, egy virtuális prototípus, esetleg a mechanizmus működését bemutató animáció.  

A koncepcionális terv alapján még nem lehet legyártani, elkészíteni az objektumot, de arról már előzetes 
véleményt lehet alkotni. A korszerű CAD szoftverek erősen támogatják a koncepcionális tervezést.  

A segédletben nem tárgyaljuk a mechanizmusok kinematikáját, amely a helyzet sebesség- és a gyorsulás-
állapotát vizsgálja, valamint a mechanizmusok dinamikáját, amely a kinematikai vizsgálatokon túl a mecha-
nizmusok erőjátékának vizsgálatával foglalkozik. Ezek vizsgálata is megoldhatóa Pro Engineer megfelelő 
moduljával. 

Munkánkban bemutatjuk a Pro Engineer szoftver alkalmazhatóságát néhány lehetséges négycsuklós szer-
kezet koncepcionális tervezésénél.  

A MECHANIZMUS VONALAS MODELLJE 

Mint ismeretes a modell nem más, mint a valós, vagy elképzelt objektum mása, szűkített információkkal 
való leképezése. A CAD szoftvereknél többnyire geometriai modellt készítenek, ahol metrikusan jellemző 
információkat képeznek le. A csuklós mechanizmusok koncepcionális tervezésénél egy másfajta / mechani-
kai / modellt kell készíteni! 

Itt a modell célja, a megfelelő a peremfeltételekkel megfogalmazott mechanizmus működéshelyes elvi 
megtervezése, az elvi modell viselkedésére vonatkozó számítások végzése [3]. Mint már említettük, az egye-
di tervezésű csuklós munkadarabefogó készülékek tervezését segítik a hasonló feladatoknál alkalmazott 
megoldások. Ennek szellemében először olyan négycsuklós mechanizmusokat tárgyalunk, amelyekhez ha-
sonló kerül / kerülhet / beépítésre egyes heverők betétjének nyitásához, csukásához / 1. ábra /, illetve néhány 
személyautónál a csomagtartó ajtajának mozgatásához / 79. ábra /. 

 
1. ábra 

Egy heverő betétjének nyitó – csukó szerkezete 
 
A 2. ábra mutatja az 1. ábrán látható csuklós mechanizmus géprajzi vázlatát. A vázlat a lényeges dolgokat 

kiemeli, a lényegtelen dolgokat elhanyagolja. A tervezés kezdeti szakaszában mindenekelőtt a mechanizmus 
működési elve, mozgásviszonya tisztázandó. Ehhez elegendő a csuklós szerkezet elemeit az ábrán látható 
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módon jelképesen vázolni. A 2. ábra a csuklókat háromszög és a csúcspontjában lévő kör, a rudakat egy – 
egy vonal jelöli.  
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2. ábra 

A mechanizmus vázlata 
 
A számítógépes környezetben a vázlat tovább egyszerűsíthető. 

 
3. ábra 

A mechanizmus számítógépes durva vázlata  

 
Az új vázlatnál a csuklók jelképei nincsenek kirajzolva, a csuklópontokat a vonalasan rajzolt elemek csat-

lakozó pontjai jelentik. A számítógépes vázlat nemcsak egyszerűsítést jelent, hanem minőségi változást is, 
hiszen a vázlat életre kelthető, mozgatható. Ez úgy érhető el egy parametrikus CAD szoftvernél, hogy a váz-
latot ellátjuk megfelelő geometriai és méretkényszerekkel, majd az egyik méretkényszert / pl. egy rögzített 
csuklóval rendelkező tag α szögállását / utólag módosítjuk.  
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4. ábra 

A mechanizmus mozgatása a szögérték változtatásával  
 
A méretmódosítás után a mechanizmus rúdjait szemléltető egyenes szakaszok felveszik a beállított mé-

retnek megfelelő új helyzetet. Tehát a számítógépes környezetben a mechanizmus vázlata hasonlóan viselke-
dik, mint maga a mechanizmus, így a vonalas vázlat a mechanizmus modelljeként kezelhető.  

A valós mechanizmusnál a b jelű rögzített csuklóval rendelkező tag szögállását változtatva a d jelű rúd 
forgó, a c jelű rúd változó lefolyású mozgást végezve veszi fel az új helyzetet. A 4. ábrán látható számítógé-
pes vonalas modell csak a beállított méretnek megfelelő helyzetet ábrázolja, de magát a mozgást nem szem-
lélteti.  

Természetesen a vonalas modell csak megfelelő geometriai adatokkal működik helyesen. A geometriai 
adatokat / a rúdhosszakat / az előírt feltételek / továbbiakban peremfeltételek / figyelembevételével kell meg-
határozni. Az eltérő peremfeltételek befolyásolhatják a feladatmegoldás menetét. 

A PEREMFELTÉTELEK MEGFOGALMAZÁSA 1 

A 2. ábrán látható négycsuklós mechanizmus középső, c hosszúságú tagját a vízszintes / 1 jelű / helyzet-
ből függőleges / 2 jelű / helyzetbe kell állítani! A két, hiányosan előírt helyzeten túl követelmény még, hogy 
a mechanizmus 2 jelű helyzetében az egyelőre ismeretlen b hosszúságú rúd a vízszintessel 95 fokos szöget 
zárjon be! A mechanizmus két megadott helyzetét biztosítsák ütközők! Az 1 jelű helyzetben a rögzített és a 
mozgó csuklók egymással h távolságban lévő párhuzamos egyeneseken találhatók. Ezenkívül a tervezés 
kezdetén, ideiglenes jelleggel vegyük fel a b és a c rúd hosszúságát / b=131, c=70 /! 

Négytagú mechanizmus tervezése a peremfeltételek 1 alapján  
A négytagú mechanizmus tervezése két előírt helyzet alapján szögfelezők alkalmazásával már régóta 

megoldott [4]. A Pro Engineer vázlatkészítő környezetében a megoldást a számítógép hathatósan támogatja.  
A parametrikus szoftvereknél főleg háromdimenziós építőelemeket hoznak létre. Az építőelemek alapja 

többnyire egy vázlat. Ennélfogva a parametrikus szoftverek fejlett vázlatkészítő környezettel rendelkeznek. 

A vázlatkészítő környezet  felhasználható segédgörbék készítésére is. A segédgörbék több geometriai 
elemből / szakasz, kör, körív / állhatnak.  

Kezdjünk új objektumot vmodell.prt névvel! Készítsük el a FRONT síkon a 3. ábrán látható mechaniz-

mus vázlatát  ! Ha a vázlatkészítő környezetben először elkészítjük a 3. ábrán látható mechanizmus vo-
nalas vázlatát / 5. ábra /, akkor a szoftver automatikus kényszerező képességének megfelelően geometriai és 
méretkényszereket helyez el. 
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5. ábra 

A mechanizmus egyik szélső helyzetének durva vázlata 
 
Az automatikus méretmegadást befolyásolja a vázlatsík kiválasztásánál felvett két méretezési referencia, 

ami az 5. ábrán kettős pont- vonalként látható.  
A szoftver automatikusan egy-egy vízszintességet / H / előíró geometriai kényszert helyezett el. Ezeket 

hagyjuk meg, és helyezzük el a peremfeltételeknél megismert méretkényszereket / 6. ábra,  h=38, b=131, 
c=70 /! A 6. ábrán az a és d szakasz / rúd / hossza még egyelőre ismeretlen, ezért a 6. ábrán gyenge méret is 
látszik / 129.88 /.  

 
6. ábra 

A mechanizmus egyik szélső helyzete az ismert méretek megadásával 
 
Rajzoljuk hozzá a másik szélső helyzetet is durva vázlatként / 7. ábra /!  

 
7. ábra 

A mechanizmus két szélső helyzetének durva vázlata 
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Adjuk meg az ismert szögértéket / 95º /, és végül a megfelelő rudaknál írjuk elő az egyenlő hosszúság 

 kényszerét. Az utolsó kényszer elhelyezésekor a vázlat geometriailag határozott lesz, azaz a 8. ábrán 
látható modell alkalmas az a és d rudak hosszának meghatározására. Ha ezeket a rúdhosszakat szeretnénk 
feltüntetni a vonalas modellnél, akkor azokat referenciaméretként tudjuk csak megadni.  

A 8. ábrán látható méret bármelyikét módosíthatjuk. A módosítás után az ábra az új méretnek megfelelő 
geometriát veszi fel. Az ábra úgy kezelhető, mint egy adott peremfeltételekkel megfogalmazott feladatokat 
megoldó automata. Ez a vonalas modell lesz a későbbiekben bemutatott optimalizálás alapja, illetve ezt lehet 
felhasználni a függő alkatrészek létrehozásánál. 

 

 
 

8. ábra 
Vonalas modell / vmodell / mint feladatmegoldó automata 

A működést szemléltető vonalas modell létrehozása 
A 8. ábrán látható vonalas modell segítségével meghatározhatjuk a peremfeltételeknek megfelelő négy-

csuklós mechanizmus ismeretlen a és d rúdhosszait. A rúdhosszak ismeretében elkészíthetünk egy olyan 
vonalas modellt, amely a 4. ábrához hasonlóan mozgatható.  

A mozgó modellhez készítsünk a vmodell-ről egy másolatot mmodell névvel! 
 

 
9. ábra 

Mentés más névvel 
 

Zárjunk be minden ablakot, és töröljük az összes modellt a memóriából! 
File ►Close Window, illetve File ►Erase ►Not Diplayed 
Ezt követően hívjuk be az mmodell.prt fájlt, és módosítsuk a vázlatot! 
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10. ábra 

A vázlat módosítása Sketch 1 ►Edit Definition ►Sketch 
 

A vázlatkészítési környezetbe lépve, töröljük le a b, c, d jelű rúd felső állásának megfelelő vonalakat! 

 
11. ábra 

A modell képe a felső állásnak megfelelő vonalak letörlése után 
 
Ilyen állapotban már nem szabad méretet módosítani, mert egy esetleges méretmódosítás esetén a modell 

nem felelne meg a peremfeltételeknek. Annak érdekében, hogy ne változzon egyetlen rúd hosszúsága sem, a 
rudak hosszát meg kell adni.  

Működés közben a modell C jelű elemének változó lefolyású mozgást kell végezni. Az ilyen mozgását je-
lenleg gátolja az elemre vonatkozó automatikusan elhelyezett vízszintességet „H” előíró geometriai kény-
szer, illetve a vízszintes rudaknál előírt 38 mm távolság. Töröljük ki ezt a geometriai, illetve méretkényszert!  

Ezt követően már megadható egy szögérték / 16,87 /, aminek változtatásával a modell különböző helyze-
te beállítható / 12. ábra /. 

 
12. ábra 

A mechanizmus közbenső helyzeteit szemléltető vonalas modell / mmodell / 
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A vázlatkészítési környezetből kilépve egy segédgörbének számító építőelemet kapunk. Ez az építőelem 
megfelel a mechanizmus mozgatható vonalas modelljének. A vonalas modellnél tetszés szerint állítható a 
szög értéke, és megfigyelhető a modell viselkedése. 

Meggyőződhetünk arról, hogy a 95 fokos szögállásnál a tervezett mechanizmus felveszi-e a kívánt szélső 
helyzetet. 

 
13. ábra 

A modell szélső állása 
 

Holtpontok meghatározása a vonalas modell alapján 
 

A Pro Engineer szoftvernél lehetőség adódik bizonyos mérési feladatok elvégzésére, illetve 
mérésépítőelem létrehozására.  

Analysis ►Measure ►Angle 

 
14. ábra 

A rudak által bezárt szög mérése 
 

A 14. ábra a vastag vonallal ábrázolt rudak által bezárt szöget szemlélteti. A két kijelölt rúd határesetek-
ben egy egyenesre esik. Ilyenkor a bejelölt szög értéke vagy 180°, vagy 0°. Ez a két határeset a mechaniz-
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musnál holtpontot jelent [4]. A holtpontokban a bejelölt szögnek szélsőérték maximuma, illetve minimuma 
van. 

A kijelölt szög / Angle /értékét a szoftver kiírja. A mérésről egy építőelemet hozhatunk létre / Add 
Feature /, melynek egy nevet kell adni / ALFA /.  
 

 
15. ábra 

A mért eredmény, a mérésépítőelem / ALFA / létrehozása  
 

A mérésépítőelem paraméterként tárolja a mért értéket. Külön parancs áll rendelkezésre a paraméter vizs-
gálatára, annak maximum, illetve minimum értékének meghatározására egy megválasztott változó függvé-
nyében. 

Analysis ►Optimization  
Változóként jelöljük ki a forgattyú mozgatására megadott szöget / Add Dimension /! A mechanizmus 

vizsgálatánál az a kérdés, hogy a holtpontok a forgattyú milyen szögállásához tartoznak. A forgattyúnak a 
meghatározott szögértékek mellett / max = 109,65° ; min =15,97° / szélső helyzete van, tovább nem forgat-
ható [4]. 
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16. ábra 

Optimalizálás 
 

Az optimalizálás végrehajtásához kattintsunk a Compute mezőre! Az optimalizálás végén a mechanizmus 
felveszi a kiszámított szélső helyzetet / 17. ábra /. 
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17. ábra 

A forgattyú maximális szélső helyzete 
 

A másik szélső helyzet meghatározásához minimalizálni  / minimize / kell a mért építőelem értékét. 

 

 
18.  ábra 

A forgattyú minimális szélső helyzete 
 
Hasonló vizsgálat végezhető el a leghosszabb rúd forgatásánál is.  
A rudak mérete befolyásolja a forgatás lehetőségét. Ennek elemzése megtalálható szakkönyvekben [pl. 4]. 

A rudak összhosszának minimalizálása  
A 8. ábrán látható vonalas modell feladatmegoldó automataként használható. Ha módosítunk egy perem-

feltételt, akkor azonnal megkapjuk az új megoldásnak megfelelő geometriai adatokat. Ez a módszeres hatás-
vizsgálaton túl az optimalizálás egyik feltételét is biztosítja.  

Matematikai értelemben az optimalizálás szélsőértékszámítást jelent. A bemutatott feladatnál azt vizsgál-
juk, hogy a b jelű rúdnak létezik-e olyan értéke, melynél a rudak összhossza minimális. Az érthetőség kedvé-
ért előzetesen bemutatjuk a MAPLE matematikai programmal végzett vizsgálat eredményét / 19. ábra /. A 
vizsgálatnál a c jelű rúd hossza 70 mm volt. Az ábrán jól látható, hogy a megadott peremfeltételek mellett 
létezik szélsőértékminimum. Úgy is fogalmazhatjuk, hogy a peremfeltételek által meghatározott mérethálózat 
mellett a rudak összhossza egy olyan függvénnyel adható meg, amelynek létezik szélsőérték minimuma, ha a 
b jelű rúd a független változó. 
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19. ábra 

A rudak összhosszának változása a b jelű rúd függvényében 
 

Az optimalizálásnál mindig egy mérés-építőelemre hivatkozunk, amikor a célfüggvényt megfogalmaz-
zuk. Tehát a rudak összhosszának minimalizálásánál mérhetővé kell tenni a rudak összhosszát. A mérhetőség 
érdekében a vázlatkészítő környezetben rajzoljunk egy egyenes szakaszt! Később tervezői összefüggéssel 
biztosítjuk a szakasz megfelelő hosszát. A tervezői összefüggések megadásánál mind a négy rúd hosszmére-
tével számolunk. Két rúdnak a méretét a peremfeltételeknél megadtuk / b=131, c=70 /, a másik két rúd hosz-
sza pedig a feladatmegoldáskor adódott ki. A kiadódó hosszakat adjuk meg referenciaméretként / d4 REF, d5 
REF 20. ábra /! 

 
20. ábra 

Referenciaméretek felvétele 
 



HALBRITTER ERNŐ : CAD  ALKALMAZÁSOK                                                   PRO ENGINEER OKTATÓANYAG 

    
15  

Széchenyi István Egyetem Győr 
HEFOP-3.3.1-P.-2004-06-0012/1. 

 
 

 

Zárjuk be a vázlatkészítő környezetet, majd alkatrészszintű tervezői összefüggéssel a d6 szakasz hosszát 
tegyük egyenlővé a rudak összhosszával / d6=d1 + d2 + d4 + d5. / ! Ezt követően mérjük meg a felvett 
szakasz hosszát / 21. ábra /! Analysis ►Measure ►Curve Length 

 
21. ábra 

A rudak összhosszának mérése 
 
A mérésről vegyünk fel egy építőelemet / Add Feature /! Az építőelem neve legyen SL! Ezek után már 

elvégezhető az optimalizálás. 
Analysis ►Optimization  

Változóként jelöljük ki a b jelű rúd méretét, vagy annak kódját / Add Dimension  ► d2 / 

 
22. ábra 

A rudak összhosszának minimalizálása 
 

Az optimalizálás elindításakor / Compute / a program egy konvergenciadiagramot készít, melynek képe 
az alábbiakban látható. 
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Optimization Goal Convergence Graph
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23. ábra 
Konvergenciadiagram  

 
A mechanizmus rúdjainak megváltozott méreteit a 24. ábrán tekinthetjük meg.  

  

 
24. ábra 

A mechanizmus rúdjainak méretváltozása 
 

A szoftver a b jelű rúd optimális hosszúságát egy alapértelmezés szerinti pontossággal határozta meg. 
Pontosabb értéket kapunk, ha a hibaszázalékot csökkentjük.  

 
25. ábra 

A számolási pontosság beállítása 
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A célfüggvény érzékenységének vizsgálata 
Az érzékenységvizsgálat olyan elemző eljárás, amely során felderíthető, hogy milyen hatással vannak az 

optimális megoldásra a modell paramétereinek értékeiben bekövetkezett változások [7]. 
A 19. ábra alapján már fogalmat alkothattunk arról, hogyha eltérünk a b jelű rúd optimális értékétől, ak-

kor milyen mértékben változik a rudak összhossza. A 19. ábra MAPLE matematikai programmal készült. 
Először ehhez hasonló ábra elkészítésének a lehetőségét mutatjuk be a Pro Engineer szoftveren belül.   

Vegyük fel a családtábla tagjai közé a független változónak számító d2 rúd hosszát és a rúdak 
összhosszát / d6 / ! Ezek az értékek szerepelnek a 19. ábra koordinátatengelyein is. 

 
26. ábra 

A családtábla részére kiválasztott értékek 

A b jelű rúd hosszát tízszer 10 mm-es lépésenként növeljük meg 130 mm-től kezdődően !  

 
27. ábra 

A d2 változó mintázat szerinti felvétele 
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A d2 értékekhez kapcsolódó d6 értékeket számíttassuk ki a szoftverrel  ! A számítások eredményét 
a VERIFY , majd a CLOSE mezőre kattintva kapjuk meg.  

 
28. ábra 

Közbenső értékek kiszámíttatása 
 

A kiszámított értékeket mentsük el Excel táblázatkezelő szoftver számára! 

 
29. ábra 

Az adatok mentése Excel táblázatkezelő szoftver számára 

 
Az Excel táblázatkezelő szoftverben az adatok ábrázolhatók / 30. ábra /. 
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30. ábra 

Az adatok ábrázolása az Excel táblázatkezelő szoftverrel 
 

A 30. ábra alapján megállapíthatjuk, hogy a rudak összhossza alig változik, ha a b jelű rúd hossza 155 és 
170 mm között van. Ilyen esetben más tervezői szempontok is előtérbe kerülhetnek.  

Az előzőekben a b jelű rúd hosszúságát optimalizáltuk. A célfüggvényt - a rudak összhosszának minima-
lizálását - más értékek is befolyásolják. Így például a peremfeltételek megfogalmazásánál említettük, hogy a 
c jelű rúd hosszát ideiglenes jelleggel vegyük fel 70 mm-re. A felvett érték egy előzetes közelítésnek tekint-
hető. A tényleges méretét főleg szilárdsági megfontolásból kell ellenőrizni. Ha túl rövid a c jelű elem, akkor 
a betét mozgatásánál nem lehet a fellépő erőt megfelelően elosztani. Szilárdsági számításra itt nem vállalko-
zunk, de azt érdemes megvizsgálni, hogy a c jelű rúd miképpen befolyásolja a rudak összhosszát. A vizsgá-
lathoz vegyük fel változónak a c jelű rudat is / Add Dimension  ►d1 /! 
 

 
31. ábra 

A második változó megadása 
 

A kétváltozós optimalizálás eredményét a 32. ábrán mutatjuk. 
 



HALBRITTER ERNŐ : CAD  ALKALMAZÁSOK                                                   PRO ENGINEER OKTATÓANYAG 

 20                                                          
Széchenyi István Egyetem Győr 

HEFOP-3.3.1-P.-2004-06-0012/1. 
 

 

 
32. ábra 

Kétváltozós optimalizálás eredménye 

 
A kétváltozós optimalizálás eredményét vizsgálva egyértelmű, hogy a c jelű rúd hossza jelentősen befo-

lyásolja a rudak összhosszát. Az is kitűnik, hogy matematikai értelemben a c jelű rúdnak nincs optimális ér-
téke. Erre utal, hogy a legkedvezőbb értékként a megadott intervallum / c= 50 – 70 mm / legkisebb értékét 
kapjuk. Úgy is fogalmazhatunk, hogy az optimalizálást a c jelű rúdnak a megengedhető legkisebb értékére 
célszerű elvégezni.  

Hasonló módon bevonható a vizsgálatba a megadott szögérték is. A szögérték megengedhető intervallu-
mát 91º és 100º között vettük fel. A harmadik változónak szintén nincs optimális értéke, de a vizsgálat to-
vábbi lehetőséget mutat a rudak összhosszának csökkentésére.  

 
33. ábra 

Háromváltozós optimalizálás eredménye 
 

A 38 mm-s beépítési méretet adottnak, véglegesnek tekinthetjük, így annak vizsgálatára nincs szükség. 
Az optimalizáló modulnál korlátozó feltételt is megadhatunk. Alkalmazzunk távolságmérést a mecha-

nizmus felső állásánál a c jelű rúd alsó pontja és a mozdulatlan vízszintes rúd között. A mért értékkel ve-
gyünk fel egy H nevű építőelemet! 
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34. ábra 

A vizsgálni kívánt távolság mérése 
 

A távolságmérés alapján az optimalizálásnál előírhatjuk / Add /, hogy a H értéke legyen kisebb egy meg-
adott értéknél / 33. ábrán H < 155 /.  
 

 
35. ábra 

A korlátozó feltétel előírása 

 
A kapott érték nem a rudak összhosszának minimuma lesz, hanem a megengedhető értékek közül a leg-

inkább megfelelő. 
 Ezt egy felvett referenciamérettel szemléltetjük / 36. ábra /.  
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36. ábra 

A megengedhető legjobb megoldás H < 155 esetén 

ALKATRÉSZEK LÉTREHOZÁSA FÜGGŐ MODELKÉNT 

A vonalas modell / vmodell.prt / elkészítésével a feladatot koncepcionálisan részben megoldottuk. Az el-
vi modellnél a rudaknak egy-egy szakasz, a csuklóknak a szakaszok végpontjai felelnek meg. A vonalas mo-
dell, mint elvi megoldás a további koncepcionális tervezést és a részlettervezést is többféle módon támogatja. 
Helyes tervezés esetén: 

• a vonalas modell felhasználható a megfelelő rudak / alkatrészek /  modellezésénél,  
• a vonalas modell módosítása kihat a megfelelő rudak méretére,   
• segíti a további munka kiosztását, az egyes alkatrészek párhuzamos tervezését. 

A felsoroltakat az un. függő modellek létrehozásával és a konkurens tervezéssel lehet elérni. A függő 
modellek összeállítási környezetben hozhatók létre. Az összeállítást a bázisalkatrész beépítésével szokás 
kezdeni. A vonalas modell formailag / a fájl kiterjesztése alapján / alkatrésznek tekinthető, így bázisalkat-
részként beépíthető.   

A vonalas modell  elhelyezése az összeállításban 
Nyissunk meg egy új összeállítást, legyen az összeállítás neve elemek.asm. Lépések:  File ► New ► 

Assambly ► sablonfájl választása / design_asm_mmns sablont /. 

Az alkatrész / adott esetben a vmodell.prt fájl / beépítéséhez kattintsunk a megfelelő ikonra , vagy  
Insert ►Component►Assemble  mezőre! 

Jelöljük ki a beépítendő alkatrészt / vmodell.prt fájlt /! 
Az alkatrész kiválasztása után megjelenik a vezérlőpult: 
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37. ábra 

A vonalas modell alapértelmezés szerinti beépítése  
 

Az alkatrész koordinátarendszerét hozzáilleszthetjük a szerelési koordinátarendszerhez, ha a vezérlőpult-

nál a Default opciót   használjuk. Ilyenkor a helyzet-meghatározás alapértelmezés szerinti, és a beszere-
lendő alkatrész minden szabadságfokát leköti / Placement Status - Fully Constrained /. A zöld pipára kattint-

va   fejezhetjük be a vonalas modell beépítését.  

A párhuzamos munkavégzés előkészítése függő modellként 
A következőkben feltételezzünk egy olyan munkamegosztást, ahol a mechanizmus rúdjainak geometriai 

modelljét külön-külön más-más ember készíti el. Eddig a vezető tervező elkészítette a vonalas modellt, be-
építette egy ELEMEK.ASM nevű összeállításba, ezután pedig előkészíti a párhuzamos munkavégzés lehető-

ségét. Az összeállítási környezetben kezdeményezi az új alkatrész létrehozását  .  Az új alkatrész neve 
legyen alkatrész1, röviden A1. 

 
 

38. ábra 
Új alkatrész létrehozása összeállítási környezetben  
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A névadás után megjelenő ablaknál kijelöli a Create features opciót. 

 

 
 

39. ábra 
Az alkatrész létrehozási módjának kiválasztása 

 
A Create Options ablak lezárása után az összeállítási környezetben az A1 nevű alkatrész lesz az aktív, 

ennél az alkatrésznél lehet új építőelemeket létrehozni. 
 

 
40. ábra 

Az aktív állapotú új alkatrész  / A1.PRT / bejegyzése 
 

A vezető tervező az A1 alkatrésznél csak annyi építőelemet készít el, annyi információt ad tovább, 
amennyi elegendő a további önálló munkavégzéshez. Jelen esetben elegendő egy vázlat készítése. Ennek 

megfelelően a vezető tervező kér egy új vázlatot . A vázlat síkjának kiválasztja a FRONT síkot / 41. 
ábra /, mivel a vonalas modell is azon a síkon készült. A méretezési referenciákat mutató ablakot üresen 
hagyja, a References ablakot bezárja / Close /. A szoftver figyelmeztető üzenetet ad, mely szerint nincs ele-
gendő referencia. Ennek ellenére a vezető tervező folytatja a munkát a Yes nyomógombra kattintva. 

 
A méretezési referenciák a mérethálózat kialakításához, egy –egy vázlatrész helyzet-meghatározásához 

kellenek. A jelenlegi esetben csak egy szakaszt kell átvenni, amely egy kiválasztott rúdnál megadja a csukló-
pontok távolságát. Az egyenes szakasz átmásolásához nincs szükség méretezési referenciára.  
 

A megfelelő szakasz átmásolásához a  ►  Single opciót kijelölve a vonalas modell megfelelő sza-
kaszára  / 42. ábra / kattint.  
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41. ábra 

Vázlatsík kijelölése 
 
 

 
42. ábra 

A kiválasztott egyenes szakasz átmásolása 
 

Ezek után befejezi a vázlatkészítést. Az így elkészített vázlat egyetlen szakaszból áll, melynek hossza 
függő viszonyban van a vonalas modell megfelelő szakaszával. Ha a vonalas modellt módosítjuk, akkor a 
szakasz átmásolt képe követi a változást. Az A1 alkatrész geometriai modellje az eddig elkészített vázlat 
alapján már felépíthető. Az A1 alkatrész  kimentéséhez az egész összeállítást aktív állapotba kell hozni.  
 

 
43. ábra 

Az összeállítás aktivizálása 
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A vázlat felhasználása 
 
A korábbi feltételezések szerint az alkatrészek geometriai modelljét külön-külön más-más személy végzi. 

Az egyik kolléga E-mail-en megkapja az A1 alkatrésznek megfelelő, egyelőre csak egyetlen szakaszt tartal-
mazó fájlt. A fájl megnyitásakor látható képet a 44. ábra szemlélteti. 

 

 
44. ábra 

Az a1 alkatrész vonalas modellje 
 

A koncepcionális tervezésnél az alkatrészt többnyire leegyszerűsítve modellezik, mert az alkatrészek 
alakját még szilárdsági, gyárthatósági, szerelhetőségi szempontból még nem tekintik véglegesnek. Jelen eset-
ben mind a négy rúd laposvasból készülhet. Az A1 alkatrész leegyszerűsített geometriai modelljét  a 45. áb-
rán látható.  

 
45. ábra 

Az A1 alkatrész leegyszerűsített geometriai modellje 
 

 A 45. ábra szerinti alkatrész kihúzással modellezhető. Mint ismeretes a kihúzás alapja egy vázlat, amit az 
adott feladatnál az alkatrész kerületét leíró zárt vonalból és azon belül két szigetből - körből - áll / 46. ábra /.  
A szigetek / lyukak / helyét az átmásolt szakasz végpontjai határozzák meg.  

 
46. ábra 

Az a1 alkatrész vázlata 
 

A 46. ábrán látható vázlat elkészítése átmeneti nehézséget jelent, mert a kapott fájl / 44. ábra / nem tar-
talmaz síkokat, így a vázlat síkját sem lehet kijelölni. Mint ismeretes a vmodell.prt elkészítésekor a vázlat 
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síkja az egyik koordinátasík volt. Utólag felvehetjük a három koordinátasíkot, ha az alkatrész geometriai 
modellje még nem tartalmaz építőelemeket. Ezt az állapotot a meglévő vázlat / sketch / elrejtésével / 
Suppress / érhetjük el.  
 

 
47. ábra 

Az  építőelem elrejtése, új vázlatsík/ok/ felvétele 
 

Ha már az A1 alkatrészfájl üres, akkor egyszerre három segédsík / koordinátasík / jeleníthető meg a 
Dutum Plane ikonra kattintva  / 48. ábra /.  

 

   
48. ábra 

A koordinátasíkok utólagos felvétele 
 

Ezek után az elrejtett építőelem  feléleszthető / Resume /.  

 
49. ábra 

Az elrejtett építőelem felélesztése 
 

A modellfán az építőelemek sorrendje  akár fel is felcserélhető / 50. ábra /.  

 
50. ábra 

Az elrejtett építőelem felélesztése 
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Az A1 alkatrész modellezésénél fontos, hogy a kapott információt megfelelően vegyük át. Kérjünk kihú-

zást! Ügyeljünk arra, hogy a kihúzás kérésekor a Sketch1 vázlat / szakasz / ne legyen kijelölt állapotban, 
mert akkor a szoftver felületmodellt készít a kijelölt szakasz felhasználásával. A vázlat síkja legyen a DTM3 
segédsík, méretezési referenciának vegyük fel a meglévő egyenes szakaszt.  
 

 

 
51. ábra 

Az információ átvétele méretezési referenciaként 
 

Az átvett méretezési referencia segít a szakasz végpontjaiban  / a csuklópontok helyén /  megrajzolni a 
köröket.  A körök páronként legyenek azonos átmérőjűek, majd a külső köröket kössük össze egy-egy érin-
tőszakasszal.  

 
52. ábra 

A vázlat közbenső állapota 
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A vázlat felesleges vonalait eltávolítva   a vázlat / 46. ábra / már alkalmas a kihúzásra.  

 
53. ábra 

Az A1 alkatrész  vázlatának kihúzása 
 

Az A1 alkatrész geometriai modellje a koncepcionális tervezés szempontjainak már megfelel, így ki-
menthető, a vezető tervezőnek visszaküldhető. A visszaküldött fájl verziószáma megnövekedett, így ha a 
vezető tervező megnyitja az ELEMEK.ASM fájlt, akkor az A1 alkatrész helyén már az 53. ábrán látható mo-
dell jelenik meg.  

 
54. ábra 

A visszaküldött A1 alkatrész megjelenése a vonalas modellre épülő összeállításnál 
 

A többi  / A2, A3, A4 / alkatrész geometriai modellje hasonlóképpen készíthető el.  
 

 
55. ábra 

A visszaküldött A1, A2, A3, A4  alkatrész  megjelenése a vonalas modellre épülő összeállításnál 
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Az alkatrészek módosítása 
 
Az alkatrészek hosszméretét a vonalas modell egy-egy szakasza határozta meg. A hosszméretek változta-

tását ennek megfelelően a vonalas modellnél / vmodell.prt / kell kezdeményezni.   
 

 
56. ábra 

A vonalas modell méretmódosítása / 38 ► 80 /  
 
 

Ha a vonalas modell módosítása után frissítjük a ELEMEK:ASM összeállítást, akkor az alkatrészek 
hosszmérete is módosul a vonalas modellnek megfelelően.  
 

 
57. ábra 

A függő alkatrészek automatikus módosulása az összeállítás frissítésénél 
  

Az itt bemutatásra kerülő ELEMEK.ASM összeállítás csak a függő alkatrészek létrehozásához, azok ha-
tékony módosításához használható, ebben a környezetben az alkatrészek között nincs szerelési kényszer, az 
alkatrészeket nem lehet mozgatni.  A mozgatáshoz, az animáláshoz az alkatrészeket egy új összeállításba kell 
szerelni. 
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ANIMÁCIÓ KÉSZÍTÉSE 

Mint már említettük a koncepcionális tervezés eredménye gyakran egy virtuális prototípus, egy animáció, 
amely a mechanizmust működés közben szemlélteti. Ebben a fejezetben azt mutatjuk be, hogyan lehet a 
négycsuklós mechanizmusnál animációt készíteni.    

A mechanizmus alkatrészeinek az összeszerelése 
Mint ismeretes a geometriai modellekből készíthetünk egy statikus összeállítást, vagy a szerelésnél bizto-

síthatjuk az alkatrészek egymáshoz viszonyított elmozdulását, pl. animáció készítésének céljából.  
 
A szerelés tulajdonképpen az alkatrészek beépítését – helyzetmeghatározását, bizonyos fokú rögzítését - 

jelenti. A számítógépes tervezésnél a szerelést az összeállítási környezetben végezzük el. Az elsőnek beépí-
tett alkatrészt bázisalkatrésznek szokás nevezni.  

A bázisalkatrész beépítéséhez mindenekelőtt egy új fájlt kell megnyitni. A fájl neve legyen animacio.asm. 
File►New►Assambly . Válasszuk sablonfájlként a mmns_asm_design sablont! 

Hívjuk be az összeállításba az első alkatrészt . Legyen ez az alkatrész az ágykerethez csavarokkal 
rögzített elem, amihez kapcsolódnak a mozgó alkatrészek. Rögzítsük ezt az alapértelmezett  /Default / hely-
zetben / 58. ábra /! 

 
58. ábra 

A bázisalkatrész alapértelmezés szerinti rögzítése 
 

Ezután hívjuk be az egyik csatlakozó alkatrészt és statikus kényszerekkel / Align, Mate / határozzuk meg 
a helyzetét! 



HALBRITTER ERNŐ : CAD  ALKALMAZÁSOK                                                   PRO ENGINEER OKTATÓANYAG 

 32                                                          
Széchenyi István Egyetem Győr 

HEFOP-3.3.1-P.-2004-06-0012/1. 
 

 

 
59. ábra 

A csatlakozó alkatrész statikus szerelése 
 
 

Az Align, illetve a Mate szerelési kényszerek a 59. ábra szerint teljesen / Fully Constrained / lekötik a 
szabadsági fokokat. Ez csak azon feltételezés / Allow Assumptions / mellett igaz, hogy a behívott alkatrész 
helyzete / ferdesége / változatlan marad. Ha ezt nem feltételezzük, akkor az Allow Assumptions felírat előtti 
zöld pipát kapcsoljuk ki. A feltételezés kiiktatásával a kényszerezés részlegessé válik / Partially Constrained 
– 60. ábra /. 
 

 
60. ábra 

A forgatási lehetőség biztosítása az előzetes feltételezés kikapcsolásával 
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A teljes kényszerezés megszüntetése után a beszerelt alkatrész a tengely körül elforgatható. Ilyen állapot-
ban a statikus kényszerezés átalakítható, konvertálható a mechanizmusoknál szükséges kényszerekre / pl. Pin 

/. A konvertálás a  ikonnal kezdeményezhető. 

  
61. ábra 

A statikus kényszerek konvertálása  
 

Szereljük be az előbb ismertetett módon a többi alkatrészt is, természetesen a csatlakozási sorrendnek, 
helyzetnek megfelelően. A záróelem szerelésénél a szoftver konfigurálásától függően előfordul, hogy  a be-
szerelendő komponensnél / zárótagnál / automatikusan  értelmezi az Align, illetve a Mate kényszereket, így 
azokat csak az összeállítási komponensnél kell kijelölni. 

A megoldás hasonló a Komponens Interfész használatához / Lásd  Képlékenyalakító technológiák számí-
tógépes tervezése 122 oldal /.  

A 62. ábrán a Placement mezőt lenyítva érzékelhetjük, hogy a beszerelendő zárótagnál a tengely automa-

tikusan kijelölt állapotban van / )Axis(4_A Align⇒ / , és a szoftver a az összeállítási referenciára vár  / 
Select assembly item /.  Az adott esetben az összeállítási referencia megfelel a bázisalkatrésznek, így jelöljük 
ki a tengely / A_4(Axis) / párját.  

Ezt követően ki kell jelölni az automatikusan értelmezett Mate kényszer párját is. 
 
 

 
62. ábra 

A záróalkatrésznél automatikusan kijelölt kényszerek  
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63. ábra 

A záróalkatrésznél automatikusan kijelölt kényszerek  
 

A 63. ábra szerint elvégezve a szerelést a beszerelendő rúd még elfordítható / Ctrl + Alt + középső egér-
gomb /, de természetesen csak akkor, ha a mozgási szabadsága nincs feltételezéssel lekötve / Allow 
Assumptions – Partially Constrained /.  

 
64. ábra 

Az elforgatott helyzetű zárótag  
 
Az elfordított helyzet jól mutatja a hiányos kapcsolatot. A szerelést csak új szerelési csoporttal / New Set / 
tudjuk folytatni.  Ha a New Set felirat nem aktív, akkor kattintsunk a Place manually ikonra.   
 

 
65. ábra 

Újabb szerelési csoport kezdése ”kézi” módszerrel  
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A Place manually ikonra kattintva már kezdeményezhető egy új szerelési csoport a  New Set feliratra kat-
tintva.   

 
66. ábra 

Új szerelési csoport kezdése / New Set /  
 

A New Set parancs kiadása után újabb / Set4 /  szerelési csoporttal dolgozhatunk tovább / 67. ábra /.  

 
67. ábra 

Automatikus helyzetmeghatározás az új  / Set4 / szerelési csoportnál 
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A Set4 csoportnál elegendő a tengelyeket igazítani. Az összetartozó tengelyek kijelölése után a statikus 

szerelési kényszereket még konvertálnunk  kell. 

 
68. ábra 

Automatikus helyzetmeghatározás az új  / Set4 / szerelési csoportnál 
 

Ha a Set4 szerelési csoportnál az Align statikus kényszeren kívül a Mate kényszert is alkalmazzuk, akkor 
a konvertálás épúgy lehetséges és szükséges, de akkor a kapcsolat a Cylinder helyett Pin lesz.  

A dinamikus kényszerekkel létrehozott összeállítás a koncepcionális tervezésnek megfelelően egy egy-
szerűsített konstrukció. A csuklóknál nem építettünk be csapokat, az alkatrészek alakja, mérete nem tartal-
maz szilárdsági, illetve valós szerelési megfontolásokat. A modell szerepe a működés szemléltetése, a terve-
zés helyességének bizonyítása. A modell az összeállítási környezetben kézzel mozgatható / Ctrl + Alt + bal 
egérgomb /.   A mechanizmusnál nem mindegy, hogy melyik elemét mozgatjuk. Erről könnyen meggyőződ-
hetünk, ha a kézi mozgatást más – más alkatrészre kattintva végezzük el. A továbbiakban a magyarázatot 
csak az A1 alkatrész forgatására korlátozzuk. Ahhoz, hogy az A1 alkatrész rögzített csuklójánál értelmezzük 
a forgatást, egy szervó motort kell felvenni az említett csukónál / Joint axis / . 

  
69. ábra 

A mozgatásra kijelölt alkatrész / A1 /  
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Szervó motor felvétele, a mozgások lehatárolása 
 

Az Applications legördülő menüben válasszuk ki a Mechanism menüpontot!  

 
70. ábra 

A modellfa kiegészítése a Mechanizm menü választásakor 
 

A kiegészített modellfán az alkalmazott kapcsolatok megjelennek : Joints ►Connection_ 1 – 
Connection_4.  

A megfelelő tengely kijelölése után a Servo Motor Definition ablaknál a választás bejegyzésre kerül / 
Connection_1_axis_1 /. 

 A grafikus képernyőn a hajtott alkatrész narancs-sárga színnel, a referencia alkatrész  pedig zöld színnel 
jelenik meg.  A forgatás irányát egy lila színű nyíllal jelöli a szofver. / The direction of motion is shown by 
the magenta arrow. Driven entity (body1) is highlighted in orange and reference entity (body2) is highlighted 
in green. / Az irány a Flip kapcsolóval megfordítható. A forgatás  pozitív iránya a mágneses erővonalak irá-
nyának meghatározásánál  alkalmazott jobbkézszabály szerint értelmezhető.   

 
71. ábra 

A szervomotor elhelyezése 
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Ebben a környezetben állíthatjuk be a mechanizmus szélső helyzeteit / Minimum Limit, Maximum Limit 

/. Kattintsunk rá a Profile feliratra, majd a speciális beállítást igénylő mezőre  ! A szélső helyze-
teket  / szögértékeket / a megjelenő Motion Axis ablaknál / 72. ábra / akkor tudjuk beírni, ha előbb a kompo-
nens referenciát, illetve a szerelési referenciát az igényeknek megfelelően kijelöljük / Select component , 
illetve assembly zero reference /. 

 
72. ábra 

Az új referenciák kijelölési lehetősége 

 
73. ábra 

Az új referenciák megadása 
 

Az új referenciák az A1, illetve az A4 alkatrésznél legyenek  lemezvastagságnak megfelelő sík felületek.  
A szög minimum értékét / Minimum Limit / a modellnél előzetesen meg kell mérni a mechanizmus kiin-

duló helyzeténél. A szög maximum értéke a peremfeltételből adódik / 95º /. 
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Ezek után bezárhatjuk az ablakokat. A mechanizmus modellje már csak a két meghatározott végállás kö-
zött mozgatható / a Ctrl + Alt + bal egérgomb tartós lenyomása mellett mozgassuk az egeret /.  

Az animáció beállításai 
Az animációnál egy képsorozatot hozunk létre, ami kimenthető, áttünés nélkül megjeleníthető. Először az 

Applications legördülő menüből válasszuk az  Animation menüpontot, majd a    ikont! 
 

 
74. ábra 

Fényképek felvétele, ütemidők beállítása 
 

A heverő emelő mozgását szemléltető animációnál elegendő ”lefényképezni” a két szélső helyzetet., a 
többit a szoftver generálja. A szélső helyzetek beállításához, a felvételek / Snapshots / elkészítéséhez a Key 

Frame Sequence ablaknál kattintsunk fényképezőgépnek megfelelő ikonra  ! A Drag feliratú ablaknál a 

nyitott tenyérre  katintva tudjuk kijelöni, mozgatni a megfelelő alkatrészt. A mozgatásnál bal egér-
gombbal kattitsunk a mozgatandó alkatrészre, majd mozgassuk az egeret az egérgombok lenyomása nélkül. 
A kívánt helyzet elérésénél bal gom kattintásával rögzíthetkük a pillanatnyi állást.  A mozgatást először vé-

gezzük el az összecsukott állapotnak megfelelő szélső helyzetig. Ezután a fényképezőgép képére  kat-
tintva készíthetünk egy felvételt / Snapshot1 /.  A második felvétel  / Shapshot2 / a nyitott állapotot rögzítse. 
Végezetül a harmadik felvétel ugyancsak az összecsukott állapotnak feleljen meg!  
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75. ábra 

A beállított helyzetek lefényképezése 
 

A sikeres felvételek után / Snapshot1 – Snapshot3 / Close –zal bezárhatjuk a  Drag ablakot!  
A Key Frame Sequence ablaknál a felvételekhez ütemidők tartoznak. Az idő változását a képrnyő alján is 

figyelemmel kisérhetjük. Alapértelmezés szerint az időskála 10 egység hosszúságú, ami az adott esetben 
nincs kihasználva.  

 
76. ábra 

Ütemidők megjelenítése 
 

Ha az ablaknál beállítjuk valamelyik felvételt, akkor a hozzá tartoző időt át lehet írni / 77. ábra /. 
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77. ábra 

Ütemidők átírása 
 

Az OK gomb megnyomásával zárjuk be az ablakot. A modelltér alsó részén lévő idősávban már az új ér-
tékek jelennek meg.  

Ha ezzel megvagyunk, már készen is áll a modellünk az animálásra. Az animació a legördülő menüből, 
vagy a megfelelő ikonra / Strart the animation /  kattinva indítható. 
 

    
78. ábra 

Az animáció indítása 
 

Ha ezt ki szeretnénk menteni mozgókép formátumú fájlba, akkor  a Playback ikonra kattintva megjelenik 
a Playback (visszajátszás) ablak. Itt a Capture gombra kattintás után beállíthatjuk a mozgókép paramétereit, a 
kimeneti fájlformátumot.  
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A PEREMFELTÉTELEK MEGFOGALMAZÁSA 2 

A 79. ábra egy személygépkocsi csomagtartó ajtajának nyitó-csukó szerkezetét szemlélteti.  

 
79. ábra 

Egy személygépkocsi csomagtartó ajtajának nyitó-csukó szerkezete [8] 
 

A szerkezet áttervezésénél ismertnek tekinthetjük a négycsuklós mechanizmus középső c jelű tagjának 
hosszát és két előírt helyzetét, valamint a rögzített csuklópontokat tartalmazó egyenesről tudjuk, hogy az 
átmegy egy adott ponton, és a koordinátarendszer X tengelyével α szöget zár be. Az α szög értéke egy meg-
engedett intervallumon belül változhat / 80. ábra /.  

x

y

b

c

c

A

B

a

d

 
80. ábra 

Vázlat a peremfeltétel magyarázásához 

Négytagú mechanizmus tervezése a peremfeltételek 2 alapján  
A tervezésnél célfüggvényként fogadjuk el a rudak összhosszának minimalizálását! 
A megoldást vezessük vissza egy egyszerűbb esetre! Válasszuk meg az α szög értékét, azaz vegyünk fel 

egy valamilyen szögben hajló egyenest az adott ponton át!  
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Az egyenesen vegyünk fel 
IB  és  IA  pontokat, majd ezeket kössük össze a két helyzetben adott c jelű 

tag megfelelő végpontjaival a 81. ábra szerint, és végül a kapott szakaszokra páronként írjuk elő az egyenlő-
ség kényszerét.  

x

y

b

c

c

A

B

a

d

B

A

 
81. ábra 

Megoldási algoritmus  
 
Az egyenlőségi kényszer érvényesülésekor megkapjuk a keresett A és B pontok helyét, illetve az A, B 

pontokhoz kapcsolódó a, b, d szakaszok hosszát. Az a, b, d szakaszok - rudak - hossza kiadódó méret. Ezek-
nek a méreteknek az értékét a Pro Engineer szoftvernél csak referenciaméretként adhatjuk meg. 

A 81. ábra is úgy kezelhető, mint egy adott peremfeltételekkel megfogalmazott feladatokat megoldó au-
tomata. A c jelű rúd hosszát, helyzetét változtatva a 81. ábra a modell frissítése után az új méreteknek megfe-
lelően változik, azaz újból meghatározza az A, B csuklópontok helyét, és ezzel együtt a mechanizmus a, b, d 
rúdjainak hosszát is.  

Ezt követően a vonalas modelltől függetlenül vegyünk fel egy egyenes szakaszt. A szakasz hosszát terve-
zési összefüggéssel adjuk meg. Az előírt tervezői összefüggés / reláció / szerint a szakasz hossza legyen 
egyenlő a rudak összhosszával.  

Az optimalizálás változójaként jelöljük ki az α szöget / 82. ábra /!   

 
82. ábra 

A szögérték optimalizálása 
 
Az optimalizálás végrehajtásakor a szoftver megkeresi, majd beállítja azt az α szögállást, amelynél a ru-

dak összhossza minimális.  
Matematikai értelemben optimális megoldásról csak akkor beszélhetünk, ha a célfüggvénynek van szél-

sőérték minimuma. Esetenként a relatív szélsőérték megkeresése is hasznos lehet.  
Ennél a mechanizmusnál is érdemes érzékenységi vizsgálatot végezni. 
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A valóságban a rögzített csuklókat nem mindig köti össze külön az a jelű rúd. Ilyenkor a rudak 
összhosszát előíró tervezői összefüggésnél az a jelű rúd méretét nem kell figyelembe venni.  

A PEREMFELTÉTELEK MEGFOGALMAZÁSA 3 

A bevezetőben már írtuk, hogy a munkadarabbefogó készülékeknél a szorítást gyakran csuklós 
szerkezetekkel oldják meg. Ezek a szorítók az egyvonalba kényszerített csuklópontok szorítási elvén 
működnek. Az áttételi arányok helyes megválasztásával kis kézi erővel nagy szorítóerő érhető el. Megfelelő 
állítócsavarok alkalmazásával ugyanazon gyorsszorítók különböző munkadarabok befogására használhatók. 
A következőkben ilyen megoldásokat mutatunk be.  

A 83. ábrán egy munkadarabbefogó készülék vázlata látható [1]. A négycsuklós mechanizmus két 
helyzetének vonalas vázlatát a 84. ábra tartalmazza. Legyen ismert a rögzített csuklópontokat összekötő a 
jelű egyenes szakasz hossza  / L=200 mm / és hajlásszöge / β=15º /! A mechanizmus b és c jelű rúdjai a 
szorítási elvnek megfelelően essenek egy egyenesbe, és a kedvező erőátadás érdekében a c jelű rúd legyen 
merőleges a d jelű rúdra! A szorítás oldásakor a d jelű rúd α szöggel, a b jelű rúd pedig γ szöggel fordul el a 
fix csuklópontja körül. A d jelű rúd hossza ideiglenesen legyen 100 mm!  

 
83. ábra 

Munkadarabbefogó készülék [1] 
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84. ábra 

A munkadarabbefogó készülék vonalas vázlata 
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Négytagú mechanizmus tervezése a peremfeltételek 3 alapján  
A tervezésnél célfüggvényként fogadjuk el, hogy a b és c jelű rudak hosszának arányát a kívánt értékre 

lehessen állítani.  
Segédgörbeként rajzoljuk meg a rögzített csuklópontok által meghatározott egyenes szakaszt, majd az 

egyenes szakasz végpontjaiból kiindulva a mechanizmus durva vonalas vázlatát a szorító és egy közbenső 
állásának megfelelően / 85. ábra /!  

 
85. ábra 

A munkadarabbefogó készülék vonalas vázlata 
 

Írjuk elő a megfelelő rudaknál az egyenlőség, a c és d jelű rudaknál a merőlegesség, a b és c jelű rudak-
nál pedig az egyvonalba esés kényszerét! Adjuk meg az ismert rúdhosszat / d = 100 mm /, és a pillanatnyi 
szögértékeket! Ezzel a vonalas modell minden szabadsági fokát lekötöttük, nem maradt egyetlen gyenge mé-
ret sem. Ebben az állapotban a b és c jelű rudak hossza csak kiadódó, referencia méretként adható meg / 86. 
ábra/.  

Végezetül a vázlatkészítő környezetben a célfüggvény megfogalmazása érdekében vegyünk egy vízszin-
tes szakaszt tetszés szerinti hosszúsággal / a 86. ábrán a szakasz hossza 50 mm /!  Kilépve a vázlatkészítő 
környezetből változtassuk meg a b, illetve a d rúd elfordulási szögét! A szögek módosítása kihat a b és c jelű 
rudak méretére, megváltozik azok hosszúságának aránya. 

Az említett rúdhosszak arányát tervezői összefüggéssel rendeljük a különálló egyenes szakasz hosszához 
/ d5= d7/d8 /! A d5, d7, d8 jelöléseket lásd 86. ábrán! A segédszakasz hosszáról készítsünk mérésépítőelemet 
/ Add Feature 87. ábra /! A mérésépítőelem paraméterként tárolja a b és c rúdhosszak arányát! 
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86. ábra 

A vonalas modellnél alkalmazott geometriai és méretkényszerek, illetve kódok 
 

 
87. ábra 

A segédszakasz hosszának mérése, mérésépítőelem létrehozása 

 
Hívjuk elő az optimalizáló modult! 
Analysis ►Optimization  
Változóként jelöljük ki a d jelű forgattyú mozgatására megadott szöget / Add Dimension /! Korlátozó fel-

tételként / Design Constraints / adjuk meg a mérésépítőelem paraméterének kívánatos értékét / R=3 /!  
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88. ábra 

A változó kijelölése, a korlátozó feltétel megadása / R=3 / 
 

Az optimalizálás során a szoftver megkeresi azt a szögértéket, amelynél a rúdhosszak aránya az előírtak-
nak megfelelő. Ilyen megoldást mutat a 88, illetve 89. ábra. Az ábrákon a b és c rudak hosszmérete 
referencianéretként szerepel. Természetesen az R értéke csak a geometriától függő intervallumon belül vál-
toztatható.  

 
89. ábra 

A korlátozó feltétel módosítása / R=4 / 
 

Ennél a négycsuklós mechanizmusnál is lehetne átfogó érzékenységi vizsgálatot végezni. Az előzőekhez 
hasonló peremfeltételeket és célfüggvényt lehet alkalmazni a 90. ábrán látható munkadarabbefogó készülék-
nél.  
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90. ábra 

Prizmás munkadarabbefogó készülék [1] 
 

Az előzőekben bemutattunk három különböző peremfeltétellel megfogalmazott feladatot. A tervezésnél 
gyakran a peremfeltételek csak részben ismertek. Ilyenkor a tervező kénytelen kitalálni a kedvező peremfel-
tételeket, illetve az optimalizálás célfüggvényét.  

A rudak összhossza csak abban az esetben minimalizálható, ha a mérethálózat által meghatározott függ-
vénynek van szélsőérték-minimuma. A peremfeltételek 1 fejezetben bemutatott példánál és az ahhoz hasonló 
mérethálózattal felépített négycsuklós mechanizmusnál a rudak öszzhosszának minimalizálása megvalósítha-
tó. 
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A REDUKÁLÁSSAL MEGOLDANDÓ FELADAT ISMERTETÉSE 

Tervezzen képlékeny hidegalakító szerszámot az ábrán látható típusfeladathoz!  

 
91. ábra 

Munkadarab 
 
A munkadarab gyártásánál huzalból induljunk ki, azt daraboljuk, majd alakítsuk készre redukálással, vagy 
előrefolyatással egy lépésben! 

r 

h1=h2=1,5 S 
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92. ábra  
A redukálás elvi ábrája 

 
 
Az ”S” laptávolság az MSZ 220-84 alapján választható.  
 

Laptávolság MSZ 220 – 84 szerint 
Sorszám Névleges méret Tűrés r 

1.  4,0 
2.  4,5 
3.  5,0 
4.  5,5 
5.  6,0 

 
+ 0 
- 0,18 

 
 
0,5 

6.  7,0 
7.  8,0 
8.  9,0 
9.  10,0 

+0 
-0,22 

 
 
1 

10.  11,0 
11.  12,0 
12.  13,0 

 
+ 0 
-0,27 

 
1,5 

1. táblázat 
Szabványos laptávolságok 

 
A hengeres és a hatlapú rész hossza a laptáv ismeretében adott / h1=h2=1,5 S /. A hengeres és a hatlapú rész 
közötti un. képlékeny alakítási zóna H magassága a D és az S méret alapján számítható ki. / Lásd később! / A 
D átmérő megegyezik valamelyik szabványos átmérőjű huzal névleges átmérőjével. Ez az átmérő az MSZ 
17784-85 szerint választható. Az ármérő kiválasztásánál figyelembe kell venni, hogy a kiinduló huzal átmé-
rője hibátlanul kiadja a munkadarab hatlapú részét, törekedve az anyagtakarékosságra, és a gyárthatóságra.  

D

S

H
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Képlékeny hidegalakításra szánt huzalok 

MSZ 17784 – 85 szerint 

Sorszám Névleges átmérő Tűrés 
1.  4,37 
2.  4,49 
3.  4,8 
4.  4,85 
5.  5,1 
6.  5,19 
7.  5,22 
8.  5,85 
9.  6,4 

+0 
-0,08 

10.  6,66 
11.  7,05 
12.  7,8 
13.  8,87 
14.  9,8 

+0 
-0,06 

15.  10,69 
16.  11,68 
17.  12,5 

+0 
-0,08 

18.  13,68 
19.  14,5 
20.  15,68 

+0 
-0,11 

2. táblázat 
Képlékeny hidegalakításra szánt huzalok 

Részfeladatok 
Készítsük el a munkadarab 3D–s geometriai modelljét a névleges méretekkel! 
Határozzuk a meg a kiinduló huzal darabolási méreteit! 
Végezzünk gyárthatósági vizsgálatot! 
Készítsük el a szerszám 3D-s geometriai modelljét! 

A MUNKADARAB GEOMETRIAI MODELLJE 

A feladat megoldásához először a munkadarabot modellezzük! A modellezés leglényegesebb része a henge-
res és a hatszögletű rész közötti átmenet képzése.  Az átmenetnél a kiinduló rúdanyag átmérőjének megfelelő 
körprofilt kell szabályos hatszögprofillá alakítani. A hatszögnél előírt lekerekítést utólag készítsük el! 

A hatszögprofil elkészítése külön vázlatként / *.sec / 
 
Mint ismeretes a Pro/Engineer szoftvernél lehetőség van önálló vázlatkészítésre. Az ilyen vázlat később, a 
modellezés során behívható, felhasználható. 
Az új fájl megnyitásánál válasszuk a Sketch opciót, adjunk a fájlnak elnevezést – Hatszog / 93. ábra / ! 
Az OK gombot megnyomva egy üres rajzterületet kapunk a vázlatkészítés eszközeivel. 
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93. ábra 

Új fájl megnyitása vázlatkészítéshez 

Középvonallal  húzzunk egymásra merőleges vonalakat és a metszéspontba  helyezzük el a koordiná-

tarendszert  az ábra szerint! 

 
94. ábra 

A koordinátarendszer felvétele 
 
 
Ezzel egy kétdimenziós, koordinátatengelyekkel ellátott rajzterületet kaptunk, ahol a vázlatkészítés a szoká-
sos módon elvégezhető. 
Rajzoljuk meg durva vázlatként a hatszög 6 oldalát! 
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95. ábra 

A hatszög durva vázlata 
 
A geometriai kényszereket / pl. az oldalak egyenlőségét / úgy kell megadnunk, hogy egyedüli méret a laptá-
volságnak megfelelő méret legyen. A megoldásnál előnyösen alkalmazható a szerkesztőkör, illetve a szer-
kesztőkörhöz előírt érintőlegesség. Vegyük fel a laptávolságot 12 mm -re! 
 

 

96. ábra 
A kimentett vázlat képe 

 
Mentsük ki a vázlatot / Save /! A mentésnél a megjelenő pár-
beszédablakot  lezárhatjuk / OK /. 
 
 
 
 
 
.  

 
97. ábra 

A vázlat mentése a munkakönyvtárba 
 
Ezt követően zárjuk be a fájlt / File ►Close Window /! 
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Az alakítási zóna létrehozása átmenettel  

Előzetes számítás paraméterek felvételével 
 
A kiadott feladatnál az átmenetet meghatározó vázlatok két párhuzamos síkon vannak. A Pro/E használatánál 
a párhuzamos síkok távolságát a vázlatkészítés után külön kell megadni. A párhuzamos síkok távolsága meg-
felel az alakítási zóna magasságának. Az alakítási zóna magasságát egy előzetes, leegyszerűsített számítással 
határozhatjuk meg. 
A gyakorlatban a kiinduló keresztmetszet is, és a redukált keresztmetszet is többnyire kör alakú. Ilyen ese-
tekben az alakítási zóna egy csonkakúpnak felel meg. A csonkakúp félkúpszögét egyes helyeken egységesen 

o13=α -ra veszik fel. Ezen szög alapján meghatározható a képlékeny alakítási zóna H magassága. A számí-

tásnál 
α

−
=

tg 2

dD
H , ahol D kiinduló huzal átmérője, d redukált átmérő. Az adott feladatnál is ezt az össze-

függést alkalmazzuk az alakítási zóna magasságának meghatározására némi módosítással. A módosított ösz-

szefüggés 
α

−
=

tg 2

SD
H , ahol S a hatszög laptávolsága.  Az értéket egytized mm pontosságra kell kerekíteni. 

A számítást célszerű a Pro/E környezetén belül elvégezni. Az előzetes számítás elvégzéséhez vegyük fel a D, 
illetve az S paramétert, és adjunk azoknak értéket. A kiinduló huzal átmérőjét első közelítésként 15 mm - re 
vegyük fel! 
 

 
98. ábra  

Paraméterek felvétele 
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99. ábra  
A paraméterek értéke 

 
A felvett paraméterekkel tervezői összefüggést  írhatunk elő / Tools / Relation /. Az összefüggések írásánál a 
szoftver nem tesz különbséget kis- és nagybetű között. 

 
100. ábra 

Az előzetes számítás elvégzése 
 
A számítás helyességét leellenőrizhetjük, ha rákattintunk a Relation párbeszédablaknál a zöld pipára. A 
Verify Relations párbeszédablak üzenete szerint az ellenőrzés sikeres volt, a Relations párbeszédablak alján 
lenyitható Local Parameters ablakban pedig látható a H kiszámított értéke. 



HALBRITTER ERNŐ : CAD  ALKALMAZÁSOK                                                   PRO ENGINEER OKTATÓANYAG 

 58                                                          
Széchenyi István Egyetem Győr 

HEFOP-3.3.1-P.-2004-06-0012/1. 
 

 

 

 
101. ábra 

A mellékszámítás ellenőrzése 
 
A felvett paramétereket / D, S /, a mellékszámítás eredményét / H / később kötjük össze a geometriai model-
lel.  

Az átmenet / Blend / parancs kiadása, az átmenet tulajdonságainak megadása 
Kezdjünk egy új modellfájlt munkadarab néven, majd hozzuk létre a bázistestet! A rúdanyagot hatszög-
keresztmetszetűre alakítjuk. Az alakítási zónát átmenettel / Blend / hozzuk létre. Az átmenet parancsot az 
Insert menüben érjük el.  

 
102. ábra 

Az átmenet / Blend / parancs elérése 
 
A redukálásnál a kiinduló rúdanyag és az alakítási zóna találkozásánál egyenes az átmenet, míg az alakítási 
zóna kilépő oldalán simított / 91. ábra /. Ezt a felemás megoldást úgy lehet modellezni, hogy egyenes átme-
netet alkalmazunk, majd a kilépő oldalon utólagos lekerekítést végzünk. / Ha a redukálás helyett előrefolya-
tást használunk, akkor a simított megoldást célszerű választani. /  
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Parallel - párhu-
zamos síkok 

között 

  
Straight - egyenes átmenet 

Smooth - simított átmenet 

 
 

Select or create a 
SKETCHING PLANE. 

Vázlatsík kijelölése / Top/  

103.  ábra 
Az átmenet  / Blend / parancs opciói 

Az első vázlat felvétele 
Az első vázlat legyen egy kör, melynek átmérője a kiinduló rúdanyag átmérőjének feleljen meg.  

 
104. ábra 

A kiinduló rúdanyag profilvázlata 
 
A kört annyi részre kell osztani / szétvágni /, ahány vonaldarabból áll a következő vázlat. A szétvágást ké-
sőbb, a hatszög profilvázlat behívása után végezzük el. 
Térjünk át a második vázlat készítésére! Nyomjuk meg az egér jobb gombját és válasszuk a Toggle  Section 
opciót! 
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105. ábra 

Vázlatváltáskor felbukkanó menü 
 
A művelet eredményeképpen az első vázlat elszürkül.  
 

Az előre elkészített vázlat importálása 
 
Az első vázlat elszürkült állapotában importáljuk az előre elkészített hatszog.sec vázlatot! 
 

  
 

 
 

106.  ábra 
A vázlat megnyitása 
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A behívott vázlat megjelenik egy szaggatott vonallal körülhatárolt területen belül. A vázlatnak egy beillesz-
tési pontja van, amit körrel, és benne keresztbe húzott vonalakkal ábrázolnak.  
 

 
107.  ábra 

A megnyitott vázlat képe 
 
A vázlat nagyítható, kicsinyíthető /Scale / és elforgatható / Rotate /.  

108. ábra 
A vázlat nagyítása, kicsinyítése és elforgatása 

 
Állítsuk be az 1:1 méretarányt / Scale 1 / és fogadjuk el az elfordítás nélküli 
állapotot / Rotate 0.0 /! Egyelőre ne zárjuk le a zöld pipával a 
párbeszédablakot, hanem kattintsunk az egér bal gombjával a behívott ábra 
beillesztési pontjára, majd a beillesztési pontot mozgassuk el a kör kö-
zéppontjába! 
 

109. ábra 
A vázlat helyének meghatározása az egér 

mozgatásával 
 
A sikeres művelet után kattintsunk a zöld pipára a 
vázlat méretarányát ill. beillesztési szögét megadó 
párbeszéd-ablaknál! Előfordul, hogy a behívott 
vázlatnál a geometriai kényszerek részint elvesznek, 
ilyenkor a vázlaton megjelenik a gyenge méret. 

 
A bemutatott példánál a gyenge mérettel rendelkező oldalt egyenlő hosszúvá tettük a szomszédjával, minek 
hatására a geometria határozott lett. 

Beillesztési pont 
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110. ábra 

Az átmenet vázlatai 
 
 
 

A vázlat haladási irányának módosítása 
 
A behívott vázlaton egy nyíl látható. A nyíl az un. kezdőpontból indul és kijelöl egy haladási irányt.  A hala-

dási irány megfordításához jelöljük ki a kezdőpontot , nyomjuk meg a grafikus képernyő fölött a jobb 
egérgombot és állítsuk be a Start Point opciót! 

 
111. ábra 

A haladási irány megváltoztatása 
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Osztópontok elhelyezése 
A kör alakú vázlaton is alakítsunk ki egy kezdőpontot és annyi további csomópontot, amennyi a hatszögpro-
filnál van! A kezdőpont, illetve a csomópontok kialakításához először aktivizáljuk a körprofil vázlatát, majd 
azon osztópontokat helyezünk el. A körprofil aktivizálását a Toggle Section nyomógomb segítségével vé-
gezhetjük el. Az első váltásnál mindkét vázlat / a köralakú is és a hatszögletű is / elszürkül, majd a következő 
kapcsolásnál lesz az elsőnek megrajzolt vázlat aktív.  

Rajzoljuk meg középvonallal  a hatszög csúcspontjain át a hiányzó szimmetriatengelyeket! Helyezzük 
el az osztópontokat a szimmetriatengelyek és a kör metszéspontjaiban! 

A vonalak osztására külön ikon áll rendelkezésre  . 
Vegyük észre, hogy az osztópontok a referenciákhoz, a középvonalakhoz tapadnak!  

 

112. ábra 
Az osztópontok elhelyezése 

 

Zárjuk le a vázlat készítését , és adjuk meg a 
vázlatsíkok távolságát! 
/ Enter DEPTH for section 2 ► A megadott érték 
ideiglenesen legyen 6 mm! A pontos értéket az 
előzetes számításnál meghatároztuk / H=6.49,  101. 
ábra /, későbbiekben ezt tervezői összefüggésként 
adjuk meg.  

 
113. ábra 

Az átmenet képe 
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A kezdőpont áthelyezése 
 
A kezdőpontok áthelyezésével az átmenetnél egy csavart felület alakítható ki. Az ilyen lehetőség a középka-
tegóriás szoftvereknél többnyire nincs meg, ugyanakkor az egyenes átmenet lényegesen egyszerűbben oldha-
tó meg. 
 

 

 

 

114. ábra 
Csavartvonalú átmenet az osztópontok áthelyezésével 

Változó sugarú lekerekítés előírása az élek mentén 
 
A feladatkiírás szerint a hatszögletű részt egy előírt lekerekítéssel kell elkészíteni. A hatszögletű profilvázlat 
eleve készülhetett volna lekerekítéssel.  Ez a megoldás tovább bonyolította volna az átmenet létrehozását, 
mert az osztópontok száma duplájára adódott volna. A lekerekítés utólag is elvégezhető. Az átmenet tulaj-
donképpen a képlékeny alakítási zóna. Ebben a zónában elősegítjük az anyagáramlást, ha a lekerekítési sugár 
értékét a körprofil felé haladva fokozatosan növeljük, azaz változó lekerekítést írunk elő. 
Egy-egy él mentén két rádiuszt kell megadni a változó lekerekítéshez. Egyet az él elején, a hatszögnél, egyet 
az él végén, a körnél.  A 12 mm-es laptávolságú hatszögnél a rádiusz értéke adott / R 1,5 /. A másik rádiuszt 
az elvégezhetőség figyelembevételével adjuk meg. A tapasztalatunk szerint a nagyabbik rádiusz értékét cél-
szerű a kör átmérőjének  25 - 40 % - ára felvenni.  
A lekerekítésnél az átmeneti zóna hat élét jelöljük ki egyszerre! A kijelölésnél közelítsük meg a kurzorral az 
átmeneti zóna egyik élét, és amikor az előválasztás jeleként az él elkékül, akkor kattintsunk egyet a jobb 
egérgombbal. Ennek hatására mind a hat él az előválasztás állapotába kerül. A sikeres előválasztást a bal 
egérgomb megnyomásával hagyhatjuk jóvá. A bal egérgomb megnyomásával a 115/1. ábrának megfelelő az 
élek kijelölése. A 115/1. ábra azt is szemlélteti, hogy a rádiusz értékét hogyan lehet megváltoztatni. Egy mé-
retszám átírását lehetővé tesszük, ha a méretszámra kettőt kattintunk a bal egérgombbal. Az ábrán látható 1,5 
mm-es rádiusz a feladatkiírásnak megfelelően érték. A változó rádiusz megadása érdekében vigyük a kurzort 
a még állandó rádiusz értékéhez, várjuk meg az előválasztást, majd tartósan nyomjuk le a jobb egérgombot. 
Amikor megjelenik az Add Radius felirat / 115/2. ábra /, akkor a bal egérgombbal kattintsunk arra. A kattin-
tás után minden élnél két rádiusz jelenik meg.  A felső rádiuszok értékét utólag írjuk át! 
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115. ábra 
A változó sugarú lekerekítések megadása 

 
Lezárva a rádiuszkészítést a modellfánál kezdeményezhetjük a méretmódosítást, illetve megtekinthetjük a 
méreteknek megfelelő kódokat.  

Tervezői összefüggések megadása 
 

Rendeljük hozzá az átmeneti zóna méretkódjaihoz a korábban felvett paramétereket / d3=H, d4=D, d5=S /! 
 

 

116. ábra 
A méretszámok / méretkódok / előhívása 

 

A méretkódok megjelenítése:  Info ► . 

A tervezői összefüggés beírható a méretmódosító ablakba is . Ilyenkor az egyenlőség jelet nem 
kell beírni, de a szándékunk megerősítését kéri a szoftver. 

 
117. ábra 

A tervezői összefüggés megerősítése 
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A kódokkal írhatjuk elő az azonos rádiuszok egyenlőségét / pl.: d10=d8; d12=d8, stb. /.  

 

 
118. ábra 

A változó sugarú lekerekítések megadása, tervezői összefüggések előírása 
 
A felső rádiuszok a megadott tervezői összefüggés alapján egyenlők, és az értéküket a d7 jelölésű méret ha-
tározza meg. Vegyük fel a d7 méretet a kiinduló átmérő negyedére / d7=D/4 /. A tervezői összefüggést írjuk 
be a Relations párbeszédablakba / Tools ► Relation /. A szoftver képes rendezni a tervezői összefüggések 

sorrendjét . A rendezésnél a d7=D/4 összefüggés előzze meg a d9=d7, stb. összefüggéseket! 
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119. ábra 

Tervezői összefüggések 
 
A tervezői összefüggések működését ellenőrizzük le, változtassuk meg a kiinduló ártérő értékét a 2. táblázat 
méretválasztéka szerint, majd frissítsük a modellt! 
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120. ábra 
A kiinduló átmérő módosítása 

 
 
 
 
 
 

 

Gyárthatósági vizsgálat mérésépítőelemek alkalmazásával 
 
A nagymértékű keresztmetszet-csökkentés jelentős alakítási erőt igényel. A redukáló erő növelésével a 
felzömülés veszélye áll fenn a kiinduló hengeres résznél. A zömülésmentes redukálás érdekében korlátozni 
kell az alakváltozás értékét. Az alakváltozás kifejezhető a kiinduló huzal 0A , és a lekerekített, szabályos 

hatszög alakú rész 1A  keresztmetszetének hányadosával. 
 
 

 

121. ábra 
A kiinduló és a redukált keresztmetszet 

 
A zömülésmentes redukálással elérhető alakváltozás értékét több tényező befolyásolja. Itt leegyszerűsítve a 

problémát, a megvalósítható logaritmikus alakváltozás értékét a 0,25 
A

A
lnr ≤=ϕ

1

0  összefüggéssel korlá-

tozzuk.  
A pontosabb érték meghatározásához javasoljuk a végeselemes vizsgálatot. 
A keresztmetszetek lekérdezésére méréseket kell végeznünk. Az Analysis legördülő menüből válasszuk ki a 
Measure-t / 122. ábra /.  
Az előugró ablakban a mérés típusának /Type/ válasszuk a terület /Area/ opciót. Jelöljük ki a mérni kívánt 
felületet. Az eredmény a Results ablakban látható / 124. ábra /. 
Az Add Feature gomb megnyomásával vegyünk fel a mérésépítőelemet! Ezt mind a két felületen (A0, A1) 
végezzük el! Az építőelemek neve legyen A0, illetve A1. A két új építőelem megjelenik a modellfán / 123. 
ábra /. A mért értékek az A0 és A1 építőelemek paraméterei. 

A 0 

A 1
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122. ábra 

Az Analysis legördülő menü 
 

 

123. ábra 
Az A0, A1 építőelemek a modellfán 

 
 
 

 
124. ábra 

Terület meghatározása 
 
A keresztmetszetek ismeretében számítsuk ki a logaritmikus alakváltozás értékét! A számítást tervezői össze-
függésként írjuk elő / Tools ► Relation /! A tervezői összefüggés beírásánál használjuk a beépített függvé-
nyeket /pl. ln /! 
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125. ábra 

Beépített függvények / fx / használata a tervezői összefüggések megadásánál 
 
A beírandó összefüggésnél hivatkozni kell a mérés építőelemekhez tartozó paraméterekre. A paraméterek 

beillesztését a Relations párbeszédablakhoz tartozó ikon  teszi lehetővé. Az ikonra kattintva egy újabb 
párbeszédablak jelenik meg. Mivel a mért értékeket építőelem-paraméterként tároltuk, ezért a Select 
Parameter ablaknál a Feature opciót kell beállítani. A beállítás után jelöljük ki az A0 építőelemet a modell-
fán. A kijelölés hatására az A0 építőelemhez rendelt terület / AREA / értéke / Value / megjelenik a párbe-
szédablakban, amit az Insert Selected nyomógomb megnyomásával illeszthetünk a tervezői összefüggésbe. 

 
126. ábra 

Építőelemhez kötött paraméternek a beillesztése egy tervezői összefüggésbe 
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A mért értékekre hivatkozva a 
1A
0A

lnr =ϕ  összefüggésnek megfelelő tervezői összefüggés 

F=ln(AREA:FID_232/AREA:FID_233). A hivatkozásnak egy másik formája is lehetséges / 
F=ln(AREA:FID_A0/AREA:FID_A1) /. 

Ellenőrizzük az összefüggés helyességét, kattintsunk a Relation párbeszédablaknál a  zöld pipára. A 
Verify Relations párbeszédablak üzenete szerint az ellenőrzés sikeres volt. A Relations párbeszédablak alján 
lenyitható Local Parameters ablakban látható az F kiszámított értéke / F=0,286 /. 
 

 

 
127. ábra 

Az alakvátozás nagyságának számítása mérésépítőelemek alkalmazásával 
 
A H és az F számított értékek, melyeket a Local Parameters ablaknál változtatni nem lehet. Erre utal az Ac-
cess oszlopban látható jelképes zárt lakat a Locke megjegyzéssel.  
A kapott eredmény / F=0,286 / alapján megállapíthatjuk, hogy a 14,5 mm-es kiinduló átmérő esetén a 
felzömülés veszélye áll fenn. Csökkentsük a kiinduló átmérőt, válasszunk a 2. táblázatból egy fokozattal ki-
sebb átmérőt / D=13,68 /! 
Ha a sikeres frissítés után rögtön megtekintjük az alakváltozás értékét, akkor azt tapasztaljuk, hogy az nem 
változott az előzőekhez képest. Vigyük a kurzort az  F=ln(AREA:FID_A0/AREA:FID_A1) sorra, és végez-

tessünk el egy ellenőrzést, azaz kattintsunk a Relation párbeszédablaknál a  zöld pipára! Az ellenőrzés 
után a szoftver már kiszámolja az alakváltozás értékét.  
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128. ábra 

A helyi paraméter új értéke 
 
Tervezői összefüggéseket több szinten is meg lehet adni (pl.: vázlat, építőelem, alkatrész stb.). A szinteket a 
Look In alatt található legördülő menüknél állíthatjuk be.  
A mi esetünkben az összefüggéseket alkatrész szinten / a legfelső szinten / adtuk meg, de az 
F=ln(AREA:FID_A0/AREA:FID_A1) összefüggés kiszámításánál a paraméterek értékét alacsonyabb szint-
ről (építőelem) kell behívni. Ezt a behívást biztosítottuk az összefüggés ellenőrzésénél, és ezt lehet biztosíta-
ni egy ismételt frissítésnél is.  
A kapott eredmény alapján megállapíthatjuk, hogy a 12 mm laptávú hatszög a 13,68 mm átmérőjű huzalból 
zömülésmentesen redukálható. 
A gyárthatóságnál az is fontos, hogy a kiinduló huzalátmérő egyértelműen biztosítsa a hatszögprofilt. Az 
átmeneti zóna alulnézeti képén láthatjuk, hogy a kiinduló átmérő mennyivel nagyobb a hatszög köré írt kör 
átmérőjénél. Ha az átmérők között nagyon kicsi a különbség, akkor az anyagáramlás szempontjából az ked-
vezőtlen lesz. A 129. ábrán látható esetet határesetként fogadjuk el. A bemutatott példánál az alakváltozás 
értéke  ϕ=0,17 / 128. ábra /.  Ettől kisebb alakváltozást ne engedjünk meg. Ha nincs megfelelő választási 
lehetőségünk, akkor válasszunk nagyobb átmérőt, és előrefolyatással oldjuk meg a feladatot!  

 
129. ábra 

A kiinduló és a hatszögprofil méretének összehasonlítása. 

Vázlatkészítés a meglévő élek vetítésével /az átmenet előtti és utáni rész 
kialakítása / 

Az átmenet előtti és utáni részt extrudálással célszerű előállítani a meglévő élek átvételével. Először vegyük 
fel a vázlatsíkot az átmeneti zóna felső lapján, referenciáknak válasszuk az élben látszódó koordinátasíkokat! 
A vázlatkészítés tulajdonképpen az élek másolásából áll. Az élek másolásánál használjuk a Loop / hurok / 
opciót! A kihúzás mérete a feladatkiírás értelmében a laptávolság másfélszerese. Az erre vonatkozó tervezői 
összefüggést utólag, alkatrész-szintű összefüggéssel adjuk meg.  
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130. ábra 

Az átmeneti zóna felső élének átmásolása, kihúzása 
 
Az átmeneti zóna alsólapján hasonlóan végezhetjük el a kihúzást. A kihúzás mélysége a laptáv másfélszere-
se. 
 

 

131. ábra 
Az átmeneti zóna alsó élének átmásolása, kihúzása 
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132. ábra 

A kihúzások után a munkadarab képe 
 
Az ábrán látható, hogy a képlékeny zóna határainál törés van a modellnél. A hengeres résznél, - a belépő 
oldalon - a törés a technológiából adódik. A kilépésnél lekerekítést kell előírni. A lekerekítés a képlékeny 
alakítási zónához tartozik. Ha azt akarjuk, hogy az átmeneti zóna hossza ne változzon / jelenleg 3,64 mm /, 
akkor az érintőkúp félkúpszöge / jelenleg 13° / fog változni. A félkúpszög túlzott növekedése a képlékeny 
alakításnál növeli az anyagáramlás energiaszükségletét. A kimeneti oldalon a túl kicsi rádiusz hasonló okok 
miatt kedvezőtlen, ugyanis a kicsi rádiusz a kilépő oldalon az anyagáramlás hirtelen irányváltással jár. Az 
adott feladatnál eltekintünk a rádiusz optimalizálásától. A rádiusz értékét vegyük fel a mindenkori laptáv 
negyedére, és engedjük meg, hogy a rádiusz a képlékeny alakító zóna méretét növelje. Ügyeljünk arra, hogy 
a lekerekítés körbefutó legyen. Körbefutó lekerekítést kapunk, ha a kijelölésnél az előválasztást követően a 
jobb egérgombbal duplán kattintunk, majd a kiválasztást bal egérgombbal megerősítjük.  A lekerekítés kör-
befutó kijelölése esetenként sikertelen. Ilyenkor a Pro/E számolási pontosságát kell növelni / EDIT ► 
SETUP ► Accuracy ► Enter Value  - pl. 0.003 /. 

 
133. ábra 

Lekerekítés előírása az átmeneti zóna kilépő oldalán 

A kiinduló huzal hosszának megadása mérésépítőelem alkalmazásával 
A darabolási hossz a kiinduló keresztmetszet és a modell térfogata alapján számítható ki. A szoftverrel 
térfogatmérést is végezhetünk. A térfogat lekérdezéséhez az Analisys legördülő menüből válasszuk ki a 
Model Analysis… mezőt! 



HALBRITTER ERNŐ : CAD  ALKALMAZÁSOK                                                   PRO ENGINEER OKTATÓANYAG 

    
75  

Széchenyi István Egyetem Győr 
HEFOP-3.3.1-P.-2004-06-0012/1. 

 
 

 

 
134. ábra 

A Model Analisys elérése 
 
A térfogatméréshez a Model Analysis ablakhoz tartozó Type legördülő menüből a Model Mass Properties 
opciót kell kiválasztani. 
Az ablak alsó részén található Compute gomb megnyomásával jelennek meg a mérési eredmények.  A mérési 
eredmények közül számunkra a térfogat / Volume / a fontos. Az Add Feature gombra kattintva egy mérés 
építőelemet hozunk létre, amely paraméterként tartalmazza a térfogatot.  
A kiinduló huzal darabolási hosszának kiszámításához tervezői összefüggést kell alkalmaznunk / Tools ► 
Relations…/. 

Az előugró Relations ablakba kell beírni az  
0

A

V
kiL =  képletnek megfelelő összefüggést.  

 

 
 

 
 

135. ábra 
A geometriai modell térfogatának számítása 

 
Tervezői összefüggéseket több szinten is meg lehet adni. Állítsuk be az alkatrész / Part / szintet! Írjuk be 
összefüggésnek az: L=… 
Az egyenlőség után a térfogatott kell folytatásként beírni. Mint már ismeretes az összefüggésbe beírhatunk 

már meglévő paramétereket /  /. A párbeszédablaknál válasszuk a Feature / Építőelem / beállítást, majd 
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a modellfán jelöljük ki az előbbiekben létrehozott Analysis1 építőelemet! Ekkor kapunk egy listát az építő-
elem paramétereiről / 136. ábra /. 

 
136. ábra 

A paraméterek listája 
 
Válasszuk ki a térfogatot / Volume /, majd kattintsunk az Insert Selected gombra. Ennek hatására a kiválasz-
tott paraméter azonosító nevével már folytatható a kiinduló huzal darabolási hosszának számítása 
L=4*VOLUME:FID_608. A FID_608 kód az építőelem azonosító neve.  
A keresztmetszet azonosító nevét hasonlóan megkeresve és beillesztve az összefüggés: 

L=VOLUME:FID_608/AREA:FID_232. Ellenőrizzük le az összefüggés helyességét  ! 
Ezután a paraméterek listájában megjelenik az L, mint paraméter, és mellette az értéke is. Az OK gomb 
megnyomásával zárjuk be az ablakot. Ezzel meghatároztuk a kiinduló huzal darabolási hosszát. 

REDUKÁLÓ SZERSZÁM GEOMETRIAI MODELLJÉNEK 
ELŐÁLLÍTÁSA 

Konstrukciós szempontok a redukálógyűrűk kialakításához 
 
A számítógéppel segített tervezésnek /CAD / és gyártásnak /CAM / egyik leggyakoribb területe a szerszám-
tervezés és szerszámgyártás. 
A szerszámtervezésnél mindig az elkészítendő munkadarabból indulnak ki, figyelembe veszik a munkadarab 
gyártására felhasznált gép / szerszámgép / csatlakozó méreteit és bizonyos technológiai, szerszámkonstrukci-
ós szempontokat.  A szerszámtervezés többnyire alkotó és nem reprodukáló munka. A munka jellegéből 
adódik, hogy a kiadott feladatnál is létezhet nyitva maradt kérdés, a szerszámtervezőtől függő megoldás. Az 
egyéni megoldások gyakran valamilyen ismeretanyagra épülnek. Ilyen ismeretanyagot közlünk ebben a feje-
zetben. 
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A tervezési feladatnál csapszeggyártó célgépek / BOLTMAKER / használatát feltételezzük. Ezeket a célgé-
peket főleg a csavargyártásra használják. 

  
137. ábra 

Csavargyártás a felhasználásra kerülő célgépen 
 
Mint már ismeretes, az adott feladatnál huzalból indulunk ki és az egyszerűség kedvéért csak darabolási, 
illetve egyszeri redukálási műveletet végzünk.   
A csapszeggyártó célgépeknél általában egyszeresen foglalt redukáló gyűrűt használnak keményfém betéttel, 
illetve acél foglalógyűrűvel. A redukálógyűrű geometriai modellezésénél eltekinthetünk a foglalástól, azaz a 
szerszám lehet egyrészes is.  
A redukáló gyűrű külső befoglaló alakját és méretét a gép csatlakozó méretei határozzák meg. Három géptí-
pusra vonatkozóan adjuk meg a csatlakozó méreteket. A gépek típusmegjelölése BOLTMAKER 5/16”, 
BOLTMAKER 3/8” és BOLTMAKER 5/8”.  
A megjelölésben szereplő számok a kiinduló huzal maximálisan megengedett átmérőjére vonatkoznak angol 
hosszegységben. 
A kiinduló huzalok maximálisan megengedett átmérője, a kész munkadarabok megengedett teljes hossza 
metrikus hosszegységben, valamint a különböző nagyságú gépek percenkénti kettőslöketeinek a száma a 
következő táblázatban láthatók: 
 

Darabolás Redukálás 
szárátmérőre 

Redukálás menet-
alapátmérőre + zömítés 

Fejkörülvágás 
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Gép Huzal maximális 
átmérője 

/ mm / 

A munkadarab 
maximális hossza

/ mm / 

Löketszám 

KL/min 

5/16 ” 8 80 90 

3/8 ” 9,5 90 80 

5/8 ” 16 160 60 
 
A táblázatban megjelölt átmérőjű huzaloknál hidegalakításra szánt acélok esetén a redukálást elvégezhetőnek 
tekintjük, ha a redukálásnál az alakváltozás értéke  0,25 r ≤ϕ . 
A redukáló-gyűrű geometriai kialakításánál vegyük figyelembe a következő szempontokat:  
A redukáló-gyűrű homloklapján célszerű egy bevezető kúpot és egy bevezető hengert kialakítani. A bevezető 
kúp alkalmazása csökkenti a nyersdarab adagolási pontosságával szemben támasztott követelményeket. A 
bevezető kúp szögértéke / α2 / 10º és 40º között változhat, a kúpos rész hossza az anyagátmérő 1/4-e, 1/3–a. 
A bevezető henger átmérője kissé nagyobb, mint a kiinduló anyagé, mélysége kb. a kiinduló átmérő fele. A 
bevezető henger alkalmazásával az igénybevétel a gyűrű homlokfelületéről eltolódik. 
A bevezető henger elhagyása esetén a bevezető kúp mélységét növelni kell. 
A kalibráló rész hossza 0,08 és 1,5 mm között változik. A kalibráló rész a redukáló gyűrűnek az a része, 
amely meghatározza a munkadarab végső alakját, méretét. Ezen a részen nem változik a szerszámüreg ke-
resztmetszete. A kisebb érték mellett csökken az anyag súrlódása, a nagyobb érték pedig az élettartam szem-
pontjából kedvezőbb. A kalibráló rész ármérőjét / laptávolságát / előnyös a redukálásnál a tűrés / d h11 / mi-
nimumára tervezni, mert akkor a szerszám némi kopás után is használható, felújítható, illetve a redukálást 
követő kismértékű rugalmas méretnövekedés nem okoz problémát. 
A kalibráló rész / redukáló váll / után egy kúpos rész következik, majd a kifutó furatátmérő. A kúpos rész 
hossza, hajlásszöge nem játszik szerepet. A kifutó furatátmérő kb. 0,1 milliméterrel nagyobb, mint a reduká-
ló váll legnagyobb mérete, a sokszög köré írt kör átmérője. Ez elég nagy ahhoz, hogy lehetővé tegye az 
anyag szabad eltávozását és elég szűk ahhoz, hogy megvezesse a kilökőcsapot, amely a munkadarabot kilöki 
a matricából. 

Módosított munkadarab előállítása az üregképzéshez 
 
Az alakos munkadarab gyártásához egy redukáló szerszámot kell készíteni. A szerszámgyártáshoz először 
elkészítik a szerszám geometriai modelljét, majd az alapján NC programot állítanak elő egy CAM szoftver 
segítségével, és végül NC szerszámgépen legyártják a szerszámot.  
A szerszám geometriai modelljét legegyszerűbben úgy kaphatjuk meg, hogy egy tömbből kivonjuk a munka-
darab átalakított, módosított geometriai modelljét.  
A módosított munkadarab elkészítéséhez mentsük el a MUNKADARAB.PRT  fájlt 
MODOSITOTTMD.PRT  névvel. 
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138. ábra 

A munkadarab mentése más névvel 
 
Ezt követően nyissuk meg az új névvel elmentett fájlt! 
 

 
139. ábra 

A módosított munkadarab behívása 

Segédgörbék előállítása metszősíkkal 
 
A Front koordinátasík a munkadarab egy olyan szimmetriasíkja, amely a hatszögletű rész síklapjain megy 
keresztül. Képezzünk egy síkmetszetet a Front koordinátasíkkal! A síkmetszetnél az átmeneti zónát egyene-
sek határolják / 141. ábra /.  
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140. ábra 

Síkmetszet kérése 
 
A síkmetszet előállításához a View menüből válasszuk ki a View Manager, majd azon belül az Xsec, illetve a 
New mezőt! A síkmetszet neve legye „A”. A névadás után a Menu Manager ablaknál fogadjuk el a felkínált 
beállítást a Done nyomógomb lenyomásával / Planar =sík, Single = egyszerű /! 

 

 
 
Plane = sík 
Jelöljük ki a Front ko-
ordinátasíkot! 

 

141. ábra 
Síkmetszet készítése 

 

A síkmetszet határoló vonalait segédgörbeként  vehetjük fel. 
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142. ábra 

Segédgörbék felvétele a síkmetszet alapján 

A bevezető kúp kialakítása forgatással 
Mint ismeretes, az alakítási zónát a redukálószerszámnál célszerű a szerszámtömb szélétől bizonyos távol-
ságra helyezni és az alakítási zónához vezető résznél egy bevezető kúpot kialakítani. A bevezető kúp model-

lezésénél a módosított munkadarabhoz forgatással anyagot adunk hozzá. A forgatásnál  a vázlatsík 
legyen a Front sík, referenciának a felkínáltakon kívül vegyük fel a hengeres rész jobboldali alkotóját, és az 
előzőleg felvett segédgörbének az alakítási zónára eső jobboldali részét.  
 

 
143. ábra 

Méretezési referenciák felvétele a bevezető kúp modellezésénél 
 
Vegyük fel a forgatás tengelyét, és a méretezési referenciák felhasználásával rajzoljunk egy derékszögű há-
romszöget! Annak érdekében, hogy a bevezető kúp jól simuljon az átmeneti zónához, a derékszögű három-
szög átfogója essen egy egyenesbe a segédgörbe segítségével felvett referenciával. Azért kellett segédgörbét 
alkalmazni, mert az átmeneti zóna szélső alkotóját a szoftverrel nem lehet méretezési referenciaként felvenni, 
vagy vetíteni.  A forgatás mértéke 360 fok legyen! 
 



HALBRITTER ERNŐ : CAD  ALKALMAZÁSOK                                                   PRO ENGINEER OKTATÓANYAG 

 82                                                          
Széchenyi István Egyetem Győr 

HEFOP-3.3.1-P.-2004-06-0012/1. 
 

 

  

144. ábra 
Vázlatkészítés a bevezető kúp modellezésénél 

 

A redukálógyűrű geometriai modellje 
 
A gépkiválasztás meghatározza a szerszám csatlakozó méreteit is. A 12 mm laptávolságú munkadarabhoz 
5/8”-os gépet választunk. A redukálógyűrű csatlakozó méreteit lásd külön segédletben [1]. A csatlakozó mé-
retek ismeretében a redukálógyűrűnél a bázistest geometriai modelljét forgatással készítjük el.  
Kezdjünk új modellt!  File ►New.. A fájl neve legyen „redukalo_gyuru” / ékezet, illetve szóköz nélkül /!  
A vázlat síkja a Top sík legyen, mert a szerszámgépnél a szerszám fekvő helyzetű.  A vázlatsík tájolására 
megfelelő a Rigth / Rigth párosítás. A felkínált méretezési referenciákat / Rigth, Front /fogadjuk el! A vázlat 
egy téglalap legyen, melynek egyik sarokpontja kerüljön a referenciatengelyek metszéspontjába. A forgatás 

tengelyét vegyük fel , majd méretezzük be a vázlatot. A forgatás 360 fokos legyen! 
 

  

145. ábra 
A redukáló gyűrű bázisteste [ Boltmaker 5/8” ] 
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Alakítsuk ki a felfogó felületet a szerszámon anyageltávolító kihúzással! 
A vázlat síkja legyen a Top sík, méretezési referencia a felkínáltakon kívül a henger alakú szerszám egyik 
alkotója.  
Vázlatként rajzoljunk egy olyan derékszögű háromszöget, melynek átfogója a henger alkotójára esik! A 147. 
ábrán látható másik háromszöget javasoljuk másolással elkészíteni! 

Ehhez a másolandó háromszöget jelöljük ki /célszerű ablakban/! Válasszuk a Másolás ikont ! Ekkor 
megjelenik a másolandó objektum egy párbeszédablak kíséretében.  

  
146. ábra 

A másolás segédeszközei 
 
A megjelent ábrát a fogópontja segítségével a helyére kell mozgatni. Ehhez a művelethez célszerű a vázlat 
fogópontját áthelyezni. A fogópont áthelyezéséhez nyomjuk meg a jobb egérgombot, tartsuk lenyomott álla-
potban, majd az új helyén / a háromszög átfogóján / kattintsunk a bal egérgombbal! Akkor jó az átmásolt 
vázlat helyzete, ha a háromszög átfogója csatlakozik a henger alkotóján felvett méretezési referenciához.  Az 
egész vázlat áthelyezése után zárjuk le a másolási műveletet a zöld pipára kattintva! Az átmásolt vázlat távol-
ságát a vízszintes méretezési referenciától külön meg kell adni / 98,5 mm /! 
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147. ábra 

A felfogófelületek kialakítása 
 
A felfogófelületeknél alkalmazzunk lekerekítést! 

 
148. ábra 

A lekerekítés helye 
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A módosított munkadarab kivonása a szerszámüregből 
 
Nyissunk egy új összeállítást! Az összeállítás neve legyen „SZERSZAM.ASM”! 
File ►New..  .. Assamble 
Az összeállításba hívjuk be a REDUKALO_GYURU.PRT alkatrészt! Az alkatrész helyzetének meghatáro-
zásához válasszuk az alapértelmezés szerintit! 

 
149. ábra 

A redukálógyűrű alapértelmezés szerinti beszerelése 
 
Ezt követően hívjuk be a módosított munkadarabot / MODOSITOTTMD.PRT /, szerelési kényszerekkel 
határozzuk meg a helyzetét!  A módosított munkadarab legyen egytengelyű a redukáló gyűrű bázistestével, 
és abból kb. 5 mm–t lógjon ki!  

 

 
150. ábra 

A módosított munkadarab beszerelése 
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Vonjuk ki a szerszámból a módosított munkadarabot! A kivonáshoz válasszuk az Edit menüből a  
COMPONENT OPERATIONS parancsot. A parancs kiadásakor megjelenik egy ablak, ahonnan válasszuk ki 
a Cut Out opciót! 

 
151. ábra 

Alkatrészek kivonása egymásból  
 
Először az alaptestet kell kijelölni, amiből kivonjuk a módosított munkadarabot! A kijelölést hagyjuk jóvá / 
OK /! 
Ezt követően a kivonandó modellt jelöljük ki, és a kijelölést hasonlóképpen erősítsük meg /OK /!  
A kivágás legyen függő viszonyban a módosított szerszámmal! A „Support associative placement for the 
feature?” - kérdésre adjunk igenlő / Y / választ! 
Az igenlő válasz esetén a szoftver elvégzi az üregképzést. Mentsük el az összeállítást, és a kapcsolódó alkat-
részeket! 
 A kivágás eredménye a REDUKALO_GYURU.PRT  modellen figyelhető meg.   

 
152. ábra 

Redukáló gyűrű az alakító üreggel 
 
Természetesen a redukáló szerszámnál az üreg átmenő jellegű, a kilökő számára még egy hengeres furatot 
kell készíteni.  
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153. ábra 

Redukálógyűrű a kilökő számára készített furattal 
 
Ezt anyageltávolító kihúzással javasoljuk elkészíteni. Fontos, hogy az átmeneti zónát egy megfelelő hosszú-
ságú redukáló váll kövesse. Ezzel kapcsolatos részletesebb tájékoztatás a 137. ábra szövegkörnyezetében 
olvasható. 
 
Ajánlott irodalom:  
 
[ 1. ]  Halbritter Ernő: Útmutató a csavargyártó  szerszámok tervezéséhez, Oktatási segédlet, SZIF, 1985, 
Győr. 
 
 

 


